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发行说明

NetApp Workload Factory for Builders 的新功能

了解 Workload Factory 的 Builders 功能的新功能。

2025年10月5日

BlueXP workload factory现为NetApp工作负载工厂

BlueXP已重命名并重新设计，以更好地反映其在管理数据基础设施中的作用。因此， BlueXP workload factory

已重命名为NetApp工作负载工厂。

2025年6月16日

克隆支持

您现在可以在BlueXP Workload Factory for Builders 中克隆一个项目。当您克隆一个项目时，Builders 会从快照
创建一个新项目，其配置与原始项目相同。克隆对于快速创建类似项目或用于测试目的很有用。您可以按照
Builders 中的说明安装新的项目克隆。

"管理BlueXP Workload Factory for Builders 项目的版本"

2025年5月4日

更新了权限术语

Workload Factory 用户界面和文档现在使用“只读”来指代读取权限，使用“读/写”来指代自动化权限。

2024年12月1日

构建者工作负载初始版本

BlueXP Workload Factory for Builders 简化了软件版本的使用和访问，无需自定义工具或脚本。它使您能够将软
件版本作为与 Perforce Helix Core 集成的即时克隆来使用，作为开发过程的便捷工作区，从而节省时间和资
源。

初始版本包括管理项目和工作空间以及使用CodeBox自动执行操作的功能。您还可以将"构建者"与Perforce Helix

Core集成、以便管理每个项目的不同版本并在它们之间快速切换。

NetApp Workload Factory for Builders 的已知限制

已知限制确定了本产品版本不支持的平台、设备或功能、或者这些平台、设备或功能无法
与产品正确交互操作。仔细审查这些限制。
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需要操作员权限

NetApp Workload Factory for Builders 需要操作员权限才能正常运行。
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开始使用

了解NetApp Workload Factory for Builders

NetApp Workload Factory for Builders 是一款面向软件构建者的快速构建环境创建工具。
它可以快速设置个人开发环境，节省时间并为开发人员提供自助服务，同时使 DevOps 团
队能够保留对基础设施的控制。使用 Builders，软件开发人员可以快速创建工作区，而无
需专门的数据存储或了解开发基础设施。

NetApp Workload Factory for Builders 是什么？

NetApp Workload Factory for Builders 旨在简化开发人员管理和交互其软件不同版本的方式。Builders 与
Perforce Helix Core 配合使用，可立即克隆软件版本并创建用于开发、QA 和 CI/CD 的工作区。

使用 Builders，您可以轻松创建一个项目，并分配一个卷来表示您的软件环境及其工件。在更新软件时，您可以
对卷进行快照，从而捕获软件在那一刻的状态。您可以立即访问任何软件版本，无需重新同步，从而节省时间和
资源。

利用NetApp ONTAP的快照和克隆功能，Builders 可以更快地访问软件的不同版本，从而更快地开发和发布更
新。

有关 Workload Factory 的更多信息，请参阅"工作负载工厂概述"。

NetApp Workload Factory for Builders 功能

NetApp Workload Factory for Builders 提供以下功能：

• 创建、编辑和删除项目

• 为定义的软件版本创建快照

• 创建和删除工作空间(基于克隆)

• 创建访问策略以控制对项目的访问

• 分析每个项目的容量使用情况

• 控制每个项目的克隆大小限制和克隆保留

• 与Perforce等版本控制系统集成

构建者中的项目和工作空间

使用"构建程序"时、您需要创建一个项目并分配一个卷来表示您的软件环境及其项目。每次创建新版本的软件
时、您都需要重新同步卷数据并创建一个项目快照、以便将卷状态标记为已知版本。项目源卷可能会进行滚动更
新、并具有多个快照来标记多个版本。您可以立即将每个快照用作即时克隆、开发人员、QA或构建流程可使用
的专用或共享可编辑存储库。特定软件版本环境中的克隆是一个工作空间。

使用 Workload Factory Codebox 实现自动化

Workload Factory通过_Codebox_引入了内置自动化功能。CodeBox具有以下自动化优势：
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• 代码段生成：基础架构即代码(IAC)代码段是在资源创建期间生成的、用于与现有业务流程无缝集成。

• 基础设施即代码副驾驶：Codebox 是一个基础设施即代码 (IaC) 副驾驶，可帮助开发人员和 DevOps 生成代
码来执行 Workload Factory 支持的任何操作。

• 代码查看器和自动化目录：代码盒提供用于快速分析自动化的代码查看器和用于快速未来重复使用的自动化
目录。

成本

使用 Workload Factory 的 Builders 功能无需任何费用。

许可

无需获得NetApp的特殊许可即可使用 Workload Factory 的 Builders 功能。

区域

在支持FSx for ONTAP的所有商业区域中、均支持构建程序。 "查看支持的 Amazon 地区。"

不支持以下AWS区域：

• 中国地区

• GovCloud (美国)地区

• 机密云

• 云的绝密

获取帮助

Amazon FSx for NetApp ONTAP是 AWS 第一方解决方案。如需帮助，请使用 AWS 管理控制台中的支持中心提
交案例。选择“FSx for ONTAP”及其类别，然后提供所需信息。

有关 Workload Factory 或 Workload Factory 应用程序和服务的一般问题，请参阅"获取 Workload Factory

Builders 的帮助"。

构建者快速入门

开始创建构建者项目。管理员和团队主管可以使用"构建者"来管理开发人员团队的项目和
工作空间。

登录工作负载工厂

你需要 "在 Workload Factory 上创建一个帐户"并使用以下任一方式登录 "控制台体验"。

添加凭据和权限

选择符合您需求的权限策略。
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如果您选择不授予权限，您可以开始使用 Workload Factory for Builders 来复制部分完成的代码示例。

如果您选择授予权限，则需要手动向帐户添加凭据，包括选择工作负载功能（例如 Builders 和 AI），并为所需
的权限创建 IAM 策略。

"了解如何添加凭据和权限"(英文)

设置您的环境以满足"构建者"要求

您需要一个已部署并发现的FSx for ONTAP文件系统、该文件系统至少包含一个已配置为NFS共享的卷。

"了解有关构建者要求的更多信息"(英文)

与其他服务集成

使用工作负载工厂REST API将构建程序与其他服务(如服务门户或Perforce Helix Core)集成。

"了解如何将构建者与Perforce集成"(英文)

下一步行动

现在、您可以"创建项目"为开发人员团队快速高效地管理代码和项目。

构建者要求

在使用NetApp Workload Factory for Builders 之前，请确保 Workload Factory 和 AWS 已
正确设置。这包括拥有您的 AWS 登录凭证、已部署的 FSx for ONTAP文件系统等等。

工作负载出厂登录和帐户

你需要 "在 Workload Factory 上创建一个帐户"并使用以下任一方式登录 "控制台体验"。

AWS 凭据和权限

您需要将具有读/写权限的 AWS 凭证添加到 Workload Factory，这意味着您将以 Builders 的读/写模式使用
Workload Factory。

目前不支持基本模式和只读模式权限。

"了解如何将 AWS 凭证添加到 Workload Factory"

FSx for ONTAP文件系统

对于ONTAP文件系统、至少需要一个FSx：

• 构建者将使用该文件系统来存储您创建的项目和工作空间。

此FSx for ONTAP文件系统必须使用FlexVol卷。不支持 FlexGroup 卷。

• 您需要了解AWS FSx for ONTAP文件系统所在的AWS区域、VPC和子网。

• 文件系统中至少需要一个具有以下配置的卷：
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◦ 必须将此卷配置为NFS共享。

◦ 必须为文件系统配置一个链接。 "了解有关链接的更多信息"(英文)。

• 您需要考虑要应用于此部署中的AWS资源的标记键/值对(可选)。

"了解如何部署和管理FSx for ONTAP文件系统"

将构建者与Perforce集成

将构建程序与Perforce Helix Visual Client (P4V)集成、以便开发人员可以使用Perforce命
令行界面管理您的工作空间。这样、开发人员就可以在项目和工作空间之间快速切换、从
而节省开发时间。

步骤

1. 下载 "P4V集成文件"。

2. 打开P4V并转到*Tools*>*Manage Tools*>*HTML Tabs*。

3. 选择*导入HTML选项卡*。

4. 选择P4V集成XML文件，然后选择*Import*。

5. 转到*View*>*Workload Factory。

结果

NetApp Workload Factory for Builders Web UI 在 P4V 客户端中显示为 HTML 选项卡。

下一步是什么？

"使用迁移顾问创建Amazon EC2部署计划"(英文)
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使用构建者工作负载

管理构建者项目

您可以管理 Builders 项目，以控制如何在NetApp Workload Factory for Builders 中管理每
个项目的代码和工件。

创建项目

您可以创建新的构建者项目、以便对代码和项目利用Amazon FSx for NetApp ONTAP文件系统的数据保护功
能。

步骤

1. 使用以下方式之一登录 Workload Factory"控制台体验" 。

2. 在“构建者”磁贴中，选择*Create project*。

3. 在创建项目页面上、提供以下内容：

a. 项目名称：输入项目名称。

b. Description：输入项目的说明。

c. 文件系统：提供以下内容：

i. 凭据：选择要使用的Amazon AWS凭据。构建者可以使用这些凭据来发现可用于此项目的FSx for

ONTAP文件系统、并创建项目的克隆和快照。

ii. 地区：选择此FSx for ONTAP文件系统所在的区域。

iii. FSx for ONTAP FilesFilesUs：选择要用于此项目的FSx for ONTAP文件系统。

您只能选择使用链接配置的文件系统。 "了解有关链接的更多信息"(英文)。

iv. 选择卷：选择要存储项目的卷；构建者使用此卷作为软件存储库。

您只能选择配置为NFS共享的卷。

d. 操作策略：为项目克隆提供限制：

i. 最大保留天数：输入克隆应保留的最大天数。在此天数之后，Workload Factory 将删除该克隆。

ii. 每个用户或组的最大克隆数：输入可为用户或组配置的最大克隆数。

iii. 以GiB为单位的最大克隆大小：输入项目克隆的最大大小(以GiB为单位)。

e. 访问策略：明确授予特定用户或组项目访问权限：

i. 策略实施范围：输入单个IP地址或IP地址范围，以将项目访问限制为只能访问这些IP地址或范围。

例如： 172.16.0.0/24

ii. 用户或组标识符：输入用户或组标识符以限制仅对这些用户或组的项目访问。

例如： User1234
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4. 选择 * 创建 * 。

结果

此时将创建项目、并显示在"项目"页面上的项目列表中。

查看现有项目

您可以按照以下步骤查看在NetApp Workload Factory for Builders 中创建的现有项目。

步骤

1. 使用以下方式之一登录 Workload Factory"控制台体验" 。

2. 在“构建者”磁贴中，选择*转至“项目”页面*。

3. 查看"项目"页面上列出的现有项目。

编辑项目

您可以随时编辑项目的设置。

步骤

1. 使用以下方式之一登录 Workload Factory"控制台体验" 。

2. 在“构建者”磁贴中，选择*转至“项目”页面*。

3. 在项目页面上、为要编辑的项目选择 。

4. 对项目配置进行任何必要的更改。

5. 选择 * 保存 * 。

查看项目的工作空间

项目的克隆或快照称为工作空间。创建工作空间时、只要项目的操作策略允许、该工作空间就会保留一段时间。
您可以按照以下步骤查看项目的现有工作空间。

步骤

1. 使用以下方式之一登录 Workload Factory"控制台体验" 。

2. 在“构建者”磁贴中，选择*转至“项目”页面*。

3. 在“项目”页面上，选择一个项目，然后选择*View*。

4. 查看此项目的所有工作区的状态和详细信息。

5. 如果您看到某个工作区的警报或警告、请将鼠标悬停在警报或警告图标上以查看原因。

删除项目

您可以按照以下步骤删除不再需要的项目。

步骤

1. 使用以下方式之一登录 Workload Factory"控制台体验" 。
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2. 在“构建者”磁贴中，选择*转至“项目”页面*。

3. 在项目页面上、为要删除的项目选择 。

4. 选择 * 删除 * 。

5. 在确认对话框中，选择*Delete*。

结果

此时将删除该项目、并从卷中删除与该项目关联的任何代码或项目。保留项目的快照和克隆。

管理NetApp Workload Factory for Builders 项目的版本

通过直接从 Workload Factory 创建按需快照和克隆，处理 Builders 项目的不同版本。项目
的快照和克隆存储在创建项目时与其关联的文件系统中。您还可以使用 "工作负载工厂
REST API"。

创建项目快照

您可以按照以下步骤创建项目快照。

步骤

1. 使用以下方式之一登录 Workload Factory"控制台体验" 。

2. 在“构建者”磁贴中，选择*转至“项目”页面*。

3. 在项目页面上、为要创建快照的项目选择 。

4. 在显示的菜单中，选择*创建快照*。

5. 在*创建快照*对话框中，选择快照的名称，然后选择*创建*。

创建项目的克隆

按照以下步骤从快照克隆 Builders 项目。创建克隆时，系统会创建一个新的可编辑卷来包含该克隆。

步骤

1. 使用以下方式之一登录 Workload Factory"控制台体验" 。

2. 在“构建者”磁贴中，选择*转至“项目”页面*。

3. 在项目页面上，选择 对于您想要克隆的项目。

4. 在出现的菜单中，选择*创建克隆*。

5. 在“创建克隆”对话框中，执行以下操作：

a. 输入克隆的名称。

克隆的默认名称是项目名称加上当前日期和时间的后缀。

b. 选择一个快照作为克隆的基础。

c. 选择 * 创建 * 。
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结果

工作负载工厂创建了该项目的新克隆，并且该克隆作为新项目出现在“项目”页面上。

创建构建者工作空间

NetApp Workload Factory for Builders 中的工作区是特定时刻项目的 Perforce 表示。工作
区是使用项目快照作为基础创建的。您可以在 Builders 项目中创建新的工作区。您可以从
Perforce UI 创建工作区。

开始之前

确保已将Build与Perforce Helix Visual Client集成在一起。有关详细信息、请参见 "将构建者与Perforce集成" 。

步骤

1. 登录到Perforce。

2. 在Perforce菜单中，选择*视图*>*工作表*。

Workload Factory 登录屏幕出现在 Perforce UI 中。

3. 使用以下方式之一登录 Workload Factory"控制台体验" 。

4. 在 Builders 工作负载图块中，选择 创建项目。

5. 选择*创建工作空间*。

6. 在Create a workspace project页面上、提供以下内容：

a. 选择要用作工作空间基础的快照。

b. 输入工作空间的名称。

c. (可选)输入用户标识符以声明此工作空间。此标识符应与将使用此工作空间的开发人员的Perforce用户ID

匹配。

7. 选择 * 创建 * 。

结果

此时将创建工作空间、并显示在Workspaces"页面上的工作空间列表中。

使用CodeBox自动执行构建者任务

您可以使用 Codebox 自动执行项目创建和数据保护操作。 Codebox 是一个基础设施即代
码 (IaC) 副驾驶，可帮助您生成代码来执行 Workload Factory 支持的任何操作。

详细了解 "CodeBox自动化" 以及如何使用它。
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知识和支持

注册以获取NetApp Workload Factory for Builders 的支持

在向NetApp技术支持部门提交支持案例之前，您需要向 Workload Factory 添加一
个NetApp支持站点帐户，然后注册以获得支持。

需要注册支持才能获得针对NetApp Workload Factory 及其存储解决方案和服务的技术支持。您必须注册NetApp

Console 的支持，它是独立于 Workload Factory 的基于 Web 的控制台。

注册支持并不能使NetApp获得云提供商文件服务的支持。有关云提供商文件服务、其基础设施或使用该服务的
任何解决方案的技术支持，请参阅该产品的 Workload Factory 文档中的“获取帮助”。

"适用于 ONTAP 的 Amazon FSX"

支持注册概述

注册您的帐户 ID 支持订阅（位于NetApp控制台中的“支持资源”页面上的 20 位 960xxxxxxxxx 序列号）作为您的
单一支持订阅 ID。每个NetApp帐户级支持订阅都必须注册。

注册后即可实现开立支持票和自动生成案例等功能。通过将NetApp支持站点 (NSS) 帐户添加到NetApp控制台即
可完成注册，如下所述。

注册您的帐户以获得NetApp支持

要注册支持并激活支持权利，您帐户中的一名用户必须将NetApp支持站点帐户与其NetApp控制台登录名关联。
如何注册NetApp支持取决于您是否已经拥有NetApp支持站点 (NSS) 帐户。

具有NSS帐户的现有客户

如果您是拥有 NSS 帐户的NetApp客户，则只需通过NetApp控制台注册即可获得支持。

步骤

1. 在 Workload Factory 控制台的右上角，选择 帮助 > 支持。

选择此选项将在新浏览器选项卡中打开NetApp控制台并加载支持仪表板。

2. 从NetApp控制台菜单中，选择 管理，然后选择 凭据。

3. 选择*用户凭据*。

4. 选择*添加NSS凭证*，然后按照NetApp 支持站点(NSS)鉴定提示进行操作。

5. 要确认注册过程是否成功，请选择帮助图标，然后选择*Support*。

“资源”页面应显示您的帐户已注册支持。
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请注意，如果其他NetApp控制台用户尚未将NetApp支持站点帐户与其NetApp控制台登录名关联，则他们将
看不到相同的支持注册状态。但是，这并不意味着您的NetApp帐户未注册支持。只要账户中有一位用户遵循
了这些步骤，那么您的账户就注册成功了。

现有客户、但无NSS帐户

如果您是现有NetApp客户，拥有现有许可证和序列号但没有 NSS 帐户，则需要创建一个 NSS 帐户并将其与您
的NetApp控制台登录关联。

步骤

1. 完成以创建NetApp支持站点帐户 "NetApp 支持站点 用户注册表"

a. 请务必选择适当的用户级别、通常为* NetApp客户/最终用户*。

b. 请务必复制上面用于序列号字段的NetApp帐户序列号 (960xxxx)。这将加快账户处理速度。

2. 完成以下步骤，将您的新 NSS 帐户与您的NetApp控制台登录关联具有NSS帐户的现有客户。

NetApp的新品牌

如果您是NetApp的新客户、并且没有NSS帐户、请按照以下每个步骤进行操作。

步骤

1. 在 Workload Factory 控制台的右上角，选择 帮助 > 支持。

选择此选项将在新浏览器选项卡中打开NetApp控制台并加载支持仪表板。

2. 从支持资源页面中找到您的帐户ID序列号。

3. 导航到 "NetApp的支持注册站点" 并选择*我不是NetApp的注册客户*。

4. 填写必填字段(带有红色星号的字段)。

5. 在*产品线*字段中、选择*云管理器*、然后选择适用的计费提供商。

6. 复制上述第2步中的帐户序列号、完成安全检查、然后确认您已阅读NetApp的全球数据隐私政策。

系统会立即向提供的邮箱发送一封电子邮件、以完成此安全事务。如果验证电子邮件未在几分钟内收到、请
务必检查您的垃圾邮件文件夹。

7. 在电子邮件中确认操作。

确认将向NetApp提交您的请求、并建议您创建NetApp 支持站点 帐户。

8. 完成以创建NetApp支持站点帐户 "NetApp 支持站点 用户注册表"

a. 请务必选择适当的用户级别、通常为* NetApp客户/最终用户*。

b. 请务必复制上面用于序列号字段的帐户序列号(960xxxx)。这样可以加快帐户处理速度。
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完成后

在此过程中、NetApp应与您联系。这是针对新用户的一次性入职练习。

拥有NetApp支持站点帐户后，请按照以下步骤将该帐户与您的NetApp控制台登录关联具有NSS帐户的现有客
户。

获取有关构建者的帮助

NetApp通过多种方式为 Workload Factory 及其云服务提供支持。全天候提供广泛的免费
自助支持选项，例如知识库 (KB) 文章和社区论坛。您的支持注册包含通过网络工单获取的
远程技术支持。

获取FSx for ONTAP支持

有关 FSx for ONTAP、其基础架构或任何使用该服务的解决方案的技术支持，请参阅该产品的 Workload

Factory 文档中的“获取帮助”。

"适用于 ONTAP 的 Amazon FSX"

要获得特定于Workload Factory及其存储解决方案和服务的技术支持、请使用下面所述的支持选项。

使用自助支持选项

这些选项每周 7 天，每天 24 小时免费提供：

• 文档

您当前正在查看的 Workload Factory 文档。

• "知识库"

搜索 Workload Factory 知识库以查找有助于解决问题的文章。

• "社区"

加入 Workload Factory 社区以关注正在进行的讨论或创建新的讨论。

向NetApp支持部门创建案例

除了上述自助支持选项之外、您还可以在激活支持后与NetApp支持专家合作解决任何问题。

开始之前

要使用*创建案例*功能，您必须首先注册支持。将您的NetApp支持站点凭据与您的 Workload Factory 登录名关
联。"了解如何注册获取支持" 。

步骤

1. 在 Workload Factory 控制台的右上角，选择 帮助 > 支持。

选择此选项将在新浏览器选项卡中打开NetApp控制台并加载支持仪表板。
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2. 在*资源*页面上、在技术支持下选择一个可用选项：

a. 如果您想通过电话与某人通话，请选择*呼叫我们*。系统会将您定向到netapp.com上的一个页面、其中
列出了您可以拨打的电话号码。

b. 选择*创建案例*向NetApp支持专家开立TT：

▪ 服务：选择*工作负载工厂*。

▪ 案例优先级：选择案例的优先级、可以是"低"、"中"、"高"或"严重"。

要了解有关这些优先级的更多详细信息、请将鼠标悬停在字段名称旁边的信息图标上。

▪ *问题描述 *：提供问题的详细问题描述 、包括任何适用的错误消息或您执行的故障排除步骤。

▪ 其他电子邮件地址：如果您希望其他人了解此问题描述 、请输入其他电子邮件地址。

▪ 附件(可选)：一次最多上传五个附件。

每个文件的附件数限制为25 MB。支持以下文件扩展名：txt、log、pdf、jp6/jpeu、rtf、 doc/docx

、xls/xlsx和csv。
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完成后

此时将显示一个弹出窗口、其中包含您的支持案例编号。NetApp支持专家将审核您的案例、并尽快与您联系。

要查看支持案例的历史记录，您可以选择*设置>时间线*并查找名为“创建支持案例”的操作。最右侧的按钮可用于
展开操作以查看详细信息。

尝试创建案例时、您可能会遇到以下错误消息：

"您无权针对选定服务创建案例"

此错误可能意味着 NSS 帐户及其关联的记录公司与NetApp控制台帐户序列号的记录公司不同（即。960xxxx）
或系统序列号。您可以使用以下选项之一寻求帮助：

• 使用产品内聊天功能

• 请通过提交非技术案例 https://mysupport.netapp.com/site/help

管理支持案例(预览)

您可以直接从NetApp控制台查看和管理活动和已解决的支持案例。您可以管理与您的 NSS 帐户和公司相关的案
例。

案例管理以预览形式提供。我们计划改进此体验、并在即将发布的版本中添加增强功能。请通过产品内聊天向我
们发送反馈。

请注意以下事项：

• 页面顶部的案例管理信息板提供了两个视图：

◦ 左侧视图显示了您提供的用户NSS帐户在过去3个月内打开的案例总数。

◦ 右侧视图显示了过去3个月内根据用户NSS帐户在公司级别开立的案例总数。

此表中的结果反映了与选定视图相关的案例。

• 您可以添加或删除感兴趣的列、也可以筛选优先级和状态等列的内容。其他列仅提供排序功能。

有关更多详细信息、请查看以下步骤。

• 在每个案例级别、我们可以更新案例备注或关闭尚未处于"已关闭"或"待关闭"状态的案例。

步骤

1. 在 Workload Factory 控制台的右上角，选择 帮助 > 支持。

选择此选项将打开NetApp控制台的新浏览器选项卡并加载支持仪表板。

2. 选择*案例管理*，如果出现提示，请将您的 NSS 帐户添加到NetApp控制台。

案例管理*页面显示与您的NetApp控制台用户帐户关联的 NSS 帐户相关的未结案例。这与出现在 *NSS 管
理 页面顶部的 NSS 帐户相同。

3. 也可以修改表中显示的信息：

◦ 在“组织案例”下，选择“查看”以查看与贵公司关联的所有案例。
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◦ 通过选择确切的日期范围或选择其他时间范围来修改日期范围。

◦ 筛选列的内容。

◦
通过选择并选择要显示的列来更改表中  显示的列。
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4. 通过选择并选择一个可用选项来管理现有案例  ：

◦ 查看案例：查看有关特定案例的完整详细信息。

◦ 更新案例注释：提供有关您的问题的更多详细信息、或者选择*上传文件*最多附加五个文件。

每个文件的附件数限制为25 MB。支持以下文件扩展名：txt、log、pdf、jp6/jpeu、rtf、 doc/docx

、xls/xlsx和csv。

◦ 关闭案例：提供关闭案例的详细原因，然后选择*关闭案例*。
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NetApp Workload Factory for Builders 的法律声明

法律声明提供对版权声明、商标、专利等的访问。

版权

"https://www.netapp.com/company/legal/copyright/"

商标

NetApp 、 NetApp 徽标和 NetApp 商标页面上列出的标记是 NetApp 、 Inc. 的商标。其他公司和产品名称可能
是其各自所有者的商标。

"https://www.netapp.com/company/legal/trademarks/"

专利

有关 NetApp 拥有的专利的最新列表，请访问：

https://www.netapp.com/pdf.html?item=/media/11887-patentspage.pdf

隐私政策

"https://www.netapp.com/company/legal/privacy-policy/"

开放源代码

通知文件提供有关 NetApp 软件中使用的第三方版权和许可证的信息。

"NetApp工作负载工厂"
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商标信息

NetApp、NetApp 标识和 http://www.netapp.com/TM 上所列的商标是 NetApp, Inc. 的商标。其他公司和产品名
称可能是其各自所有者的商标。
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